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ADVANCED OUTLOOK

MAIL MANAGEMENT

1 OF 7 (1-2 ENHANCING MAIL)

A vCard - sometimes known as an electronic business card - is an effective way to exchange contact information in both text and image form.  And vCards are compatible with a number of contact managers, for example ACT! and Lotus Organizer.  You can use vCards with plain text, RTF, and HTML messages.  Adding a vCard to a mail message saves time and helps to ensure the accuracy of the contact details.  You create a vCard in Outlook by selecting the contact that you want to convert to a vCard.  And you select File - Save As.  In the Save As dialog box you select vCard files (.vcf) from the Save as type drop-down list.  The filename is automatically created to match that of the contact name so you select a location for the file and you click the Save button.  To add a vCard to a message, you place the insertion point in the body of the message.  And you select Insert - File.  You locate and select the vCard that you want to add to your message.  And you click Insert.  The vCard is then included in the message.  You can send a vCard of a contact even if the contact is not already in vCard form.  To do this, you select the contact that you want to forward as a vCard.  And you select Actions - Forward as vCard.  Outlook opens the message form, creates the vCard, and attaches the card to the message.  Receiving a vCard in a mail message is convenient when updating your contacts.  You can update your Contacts folder by dragging a vCard that you have received to the Contacts folder.  The details of the new contact or additional details of an existing contact within the vCard are automatically entered into your Contacts folder.  Dragging an ordinary message to the Contacts folder also creates a new contact but only the name and e-mail address are transferred.  The vCard demonstrates one of the ways that the mail component is closely associated with the Contacts components.  The mail component integrates with all the components of Outlook.  For example, task status reports can be assigned automatically to people via mail.  And when scheduling a meeting, Outlook automatically allows you to contact attendees by mail.  The mail component is also integrated across the other Office applications allowing you to send e-mail from any Office application.
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Outlook allows you to use HTML formatting when you need more options than plain text or rich text format (RTF) offers.  HTML formatting can be read by many different mail applications.  However, if the recipient's mail application cannot read HTML, your mail will be converted to plain text.  If you choose to use HTML formatting for your message, you can add HTML formatting such as horizontal lines and graphics to your message.  And you can select HTML stationery for your message.  This includes a set font and a background color or picture that enhances your mail's overall look.  Your recipients will need to open the mail in a browser when you use HTML stationery.  To set HTML as the format for a message, you select Tools - Options.  Then you click the Mail Format tab.  And you select HTML from the Send in this message format drop-down list.  The Mail Format tabbed page allows you to select a favorite font or stationery.  And you can select a signature with which to end your mail messages.  You can only use Word as your mail editor if you have Word 97 or later.  Word does not support digital signatures, but most of the formatting can be read by recipients with an RTF mail editor.  It supports stationery and you can use themes or create templates for mail messages.  If you select Word as your mail editor, you gain access to Word menus within Outlook and so you can use most of Word's formatting features.  These include graphics, tables, and the spelling and grammar checker.  Word can act as your e-mail editor whether you choose to send mail in HTML, RTF, or plain text.  Let's say that you have chosen Word as your mail editor and you want to use a theme in a mail message.  To select a mail template, you select Format - Theme.  You then browse the available themes until you find one that you like and click OK.  You can create a new template for your mail messages using Word.  To create a new template, you select File - New while in the Word application.  Next you select the template that your mail messages are based on - E-mail Message.  And you select the Template radio button from the Create New section and click OK.  You can add or remove features in the template in order to customize it.  You select File - Save As.  Then you ensure that the Save as Type text box is set to Document Template (*.dot).  Once you have renamed the new mail template, you click the Save button.  Then, when you want to use the template for your mail messages, you select it from the New dialog box and click OK.  And you create your message.

3 of 7 (3-4 ORGANIZING MAIL)

A Personal Address Book (pab) is one of many possible address books that you can use with Outlook.  The pab is personal as opposed to global and so is not a shared address book.  The advantage of using a pab over using Contacts is that a pab comes in a file format that can be stored - with various security measures - on a server.  To use a pab, you have to configure Outlook for Corporate or Workgroup support.  To include a pab in your profile, you select Tools - Services.  In the Services dialog box you click the Add button.  And you select Personal Address Book from the Available information services list and you click OK.  The default name for a pab is mailbox.pab - you can select this name and the existing path to connect to your profile or you can specify a new name and path for a new pab.  In the Notes tabbed page you can type any notes regarding the pab for organizational purposes and you click OK to add the pab to your profile.  A message box displays informing you that you need to restart Outlook and you click OK.  To close the dialog box, you click OK.  And you exit and log off from Outlook.  Using your pab or Contacts you can create personal distribution lists for mail that you often send to particular sets of people.  For example, if you regularly mail a progress report to four different managers, you can create a distribution list that includes these managers.  This method saves you from having to enter each manager's address separately every time you send the report.  Let's say that you want to create a distribution list, called Progress Report, that includes three members to whom you send mail directly.  To create a distribution list in your pab, you select Tools - Address Book.  Alternatively, you can select File - New - Distribution list.  And you click the New Entry button on the Address Book toolbar.  You select New Distribution List from the Select the entry type text box.  And you select Personal Address Book from the In the drop-down list.  You select Personal Distribution List in the New Entry dialog box and you click OK.  You enter the name of the distribution list that you want to create in the Name text box on the Distribution List tabbed page.  And you click the Add/Remove Members button to select the members for your list.  You choose the address book that contains the member names that you want to add to your list from the Show Names from the drop-down list.  Next you select a member's name, Joe Mendez, from the Entries list and you click the Members button.  You repeat this process for the other members and when you have finished, you click OK to close the Edit Members of Progress Report dialog box.  And you click OK to close the dialog box.

4 of 7

You can set rules that organize where particular messages are placed and how they appear in your Inbox and Sent Items folder.  The Rules Wizard can evaluate 11 different types of rule such as moving messages - containing particular information - to a specified folder.  And it carries out specified actions on messages that meet a given set of criteria.  The Rules Wizard can automatically color, delete, flag, forward, or move incoming and outgoing mail.  To set a rule for incoming mail, you select Tools - Rules Wizard.  You click the New button to begin creating a new rule.  You then select the type of rule that you want the wizard to apply - for example Move new message from someone.  A description of the selected rule is displayed with all the modifiable options underlined in the Rule description text box.  To set the details of the rule, you click the underlined text - people or distribution list.  And then you select an option - in this case Anita Cook - and click OK.  Once you have set the basic premise of the rule, you click Next.  The displayed window allows you to set conditions for when the action should be carried out - for example, where my name is in the To box.  And once you have assigned the conditions that you want, you click Next.  You can specify actions, additional to the basic rule that will apply to the mail, using options from the What do you want to do with the message? text box.  You can edit the content in the description text box and you click Next.  You can select one or more exceptions to the rule from the Add any exceptions text box and click Next.  In the final window of the Rules Wizard you can specify a name for the rule in the relevant text box.  And you can choose to run the rule immediately by selecting the Run this rule now … in "Inbox" checkbox.  You ensure that the rule will be activated by selecting the Turn on this rule checkbox and you click Finish.  You click OK to close the Rules Wizard dialog box.  The messages meeting your criteria are then automatically moved to the specified folder.

5 of 7 (5-7 REMOTE AND OFFLINE MAIL)

If you are likely to need information while you are out of the office, you can use offline folders.  In order to use offline folders, you require Microsoft Exchange Server as a service in your profile.  Offline folders mirror other folders set up on your exchange server and data in both sets of folders can be manipulated according to your needs.  This feature allows you to dial up your exchange server and then synchronize selected folders on the server with the offline folders on the computer that you have with you.  In order to use offline folders, you select Tools - Services from you Inbox window.  You select Microsoft Exchange Server.  And you click the Properties button.  You click the Advanced tab in the Microsoft Exchange Server dialog box.  And you click the Offline Folder File Settings button.  You then enter a new path for the offline folder file or you accept the default location and click OK.  The Offline Folder File Settings dialog box allows you to choose one of three encryption options - no encryption, compressible encryption, and best encryption.  The Compressible Encryption option allows the best compression and so is recommended for users who need to conserve space on their hard drives.  The best encryption option is the most secure option and allows you to use a disk compression program, but this offers less compression than the compressible encryption option.  The encryption option that you select for your offline folders cannot be changed so you need to consider the options carefully.  Once you have made your selection, you click OK.  The offline folder file is saved with an .ost extension. And if no folder file has been created, you will be prompted to create one by clicking a Yes button.  After creating your offline folder, you specify the dial-up connection you want by clicking the Dial-Up Networking tab.  You select the connection from the Dial … connection drop-down list.  And you type your user name, password, and domain name in the specified text boxes and click OK.  To have access to a folder while offline, you select Tools - Options from the Inbox interface.  The Inbox, Outbox, Sent Items, Deleted Items, Calendar, Contacts, Journal, Tasks, Notes, and Drafts folders are automatically made available as offline folders.  On the Mail Services tabbed page you select the Enable offline access checkbox.  And you click the Offline Folder Settings button.  You select any additional folders that you want to be available while offline and you can choose to filter particular folders or specify download options.  Once you have finished, you click OK.  You click OK to close the dialog box and your folders are then available when you are offline.
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Synchronizing offline folders ensures that the folders on your server and the folders you use offline are updated to contain the same information.  To synchronize your offline folders manually, you select the folder that you want to synchronize.  Then you select Tools - Synchronize - This Folder.  To synchronize all folders, you select the All Folders option.  At this point, depending on your configuration, you may be prompted to log on to the Windows NT server.  An icon is displayed showing that the synchronization is in progress.  If you need to cancel the synchronization, you click the down-pointing arrow next to the icon and select the Cancel Synchronizing option from the pop-up menu.  You can set folders to synchronize automatically by selecting Tools - Options.  Upon the Mail Services tabbed page you select the checkbox that meets your needs, for example, the When online, synchronize all folders upon exiting checkbox.  And you click OK.  You can use the synchronization method that synchronizes a specific group of offline folders.  To do this, you select Tools - Synchronize - Offline Folder Settings.  In the dialog box displayed you click the Quick Synchronization tab.  You click the New button on the Quick Synchronization tabbed page.  Then you type a name for the group and click OK.  You click the Choose Folders button.  You select the checkboxes that correspond with the folder that you want included in the group and you click OK.  You can also set downloading options to reduce connection costs when you synchronize your offline folders.  Let's say that you want to restrict the size of messages that you download when synchronizing your folders.  To do this, you click the Download Options button.  In the Message size limit section of the dialog box you select the Don't download messages larger than checkbox.  You enter the maximum number of kilobytes per message that you will allow to be downloaded - all messages larger than this will be stored in a special folder on the server.  Then you select any exceptions that should apply and you click OK.
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Offline folders allow you to access a wide range of Outlook data.  But if you only need access to your mail while you're out of the office, you can set up the remote mail feature instead.  This feature allows you to download the headers of all the messages that you receive and to select those that you want to retrieve.  Once your computer is set up to use the Remote Mail feature, you can connect to a server and download messages.  To do this, you select Tools - Remote Mail - Connect while in the Inbox.  You select an information service and you click Next.  Then you specify the actions that you want to complete, for example you can choose to retrieve new message headers, and you click Finish.  Once you have received the message headers from your network server, you mark them according to the action that you want taken on them.  The options available to you are retrieving or not retrieving the message, retrieving a copy of the message, and deleting the message.  Let's say that you want to retrieve the first two messages, retrieve a copy of the third message, delete the fourth message from both the server and your computer, and leave the fifth message on the server.  You select the first two message headers and you click the Mark to Retrieve button.  To retrieve a copy of the third message, you select the header and click the Mark to Retrieve a Copy button.  And you select the fourth message header and click the Delete button.  Because you don't want to retrieve the fifth message, you leave it as it is.  Once you have marked the message headers, you connect to the server again.  And the messages that you have marked for retrieval are transferred to your computer.

END OF MAIL MANAGEMENT

SUMMARY: You have seen how to manage mail.  Outlook 2000 allows you exchange contact details in the form of electronic business cards or vCards. You can convert existing contacts into vCards and attach these to your mail messages.  You can customize mail messages using HTML formatting that allows the messages to contain any formatting option that can be used on a web page. You can also choose to use Word as your e-mail editor if you use HTML formatting. Using Word allows you to create document templates that you can use to create mail messages.   Creating and sending messages can be done from Outlook components other than the Mail component and it can be done from other Office 2000 applications.  When you setup Outlook for a corporate or workgroup configuration, you need to create a Personal Address Book (pab). A pab allows you to create personal distribution lists that include several recipients in a single address.  Whatever your Outlook setup, you can organize your mail by using the Rules Wizard for messages. This wizard allows you to set rules with conditions, actions, and exceptions. The rules wizard can move, copy, flag, color, and delete specified messages automatically.  You can access Outlook while you're away from the office by using offline folders if you have the Exchange Server service setup. These folders are copies of folders on your server. Changes you make to offline folders or the folders on your server can be synchronized automatically or manually. You can also create a Quick Synchronization group if you only want to synchronize a few particular folders.  If you only need access to your mail while offline, you can use the Remote Mail feature. This allows you to download message headers to select the messages that you want to download. You can also set limits on the size of messages that you want to download or you can delete unwanted messages from both your server and computer.

UNIT TEST:

1. Which of the following mail formats are compatible with vCards?

a. Plain text

b. RTF

c. HTML

d. Word

2. Which of the following are true of vCards?

a. They are compatible with contact managers other than Outlook?

b. They are saved using the .vcf file extension

c. You need to convert contact information manually into vCard format before you can forward it as a vCard

d. You can create a new contact by dragging a vCard into your Contacts folder

3. Which of the following are true of using Word as your mail message editor in Outlook?

a. E-mail sent in Word format can only be read by recipients who have Word 97 or higher

b. Word allows you to send vCards in mail messages

c. Word does not support digital signatures

d. Word allows you to use templates for mail messages

4. Which of the following are possible with HTML formatting in mail messages where Word is not the mail editor?

a. The use of custom e-mail templates

b. The use of e-mail stationery

c. Inserting horizontal lines

d. Inserting graphics

5. Which of the following can be used to define rules using the Rules Wizard?

a. Actions

b. Preferences

c. Conditions

d. Exceptions

6. Which of the following file types do you need to create before you can create personal distribution lists?

a. .vcf

b. .doc

c. .pst

d. .pab

7. Which of the following does a personal distribution list contain?

a. vCards of members of the list

b. Names and configuration details of the mail services attached to your profile

c. E-mail addresses of list members

d. Contact details of all members that share a particular e-mail subscription

8. Which of the following actions can be carried out automatically using the Rules Wizard?

a. Deleting a message

b. Flagging a message

c. Forwarding a message

d. Creating a vCard from a message

9. Which of the following services do you need to make use of offline folders?

a. Internet only

b. Microsoft Exchange Server

c. Microsoft Mail

d. A Personal Address Book

10. Which of the following offline folder options do you need if you have lots of storage space and high security needs?

a. No encryption

b. Compressible encryption

c. Best encryption

11. Which of the following are true of accessing Outlook as a mobile user?

a. Before each dial-up on a single profile, you can set your compression and encryption options

b. Offline folders can be synchronized automatically

c. Offline folders apply to mail items only

d. Remote mail is the most economical method of accessing mail while away from the office

12. Which of the following options can be used to reduce download costs when using offline folders?

a. Creating folder groups for synchronization

b. Marking only the message headers that you want to download

c. Setting download options to reject large items

d. Filtering data for downloading

13. Which of the following options are possible with Remote Mail?

a. Downloading messages without their attachments

b. Deleting unwanted messages

c. Coping messages

d. Retrieving messages

ANSWERS:

1. a, b, c & d

2. a, b & d

3. b, c & d

4. b, c & d

5. a, c & d

6. d

7. c

8. a, b & c

9. b

10. c

11. b & d

12. a, c & d

13. b, c & d

ADVANCED OUTLOOK

COLLABORATION

1 OF 11 (1-4 CALENDARING AND INTERNET SCHEDULING)

You can customize your Outlook calendar to make appointments and schedule meetings over the Internet.  You can also customize the appearance of your calendar to reflect time zones and the holidays in other countries.  This allows you to schedule meetings or communicate more easily with coworkers in other countries or time zones.  To configure your calendar, you select the Tools menu.  And you select Options.  Then on the Preferences tabbed page of the Options dialog box, you click the Calendar Options button.  The Calendar work week section allows you to adjust the first day of the week on your calendar, for example you can select Monday rather than Sunday.  You can also select a Start time and End time for the working day - that is, the period that you are available for meetings during the day.  And you can determine the first working week of the year in this section.  The Calendar options section allows you to customize Outlook to use your country's calendar and to show the week numbers.  You can also click the Color down-pointing arrow to select a new background color for your calendar.  If you administer meeting resources, you can click the Resource Scheduling button to specify settings for the resources.  In the Resource Scheduling dialog box you can select the Automatically … cancellations checkbox to ensure that the resource schedule remains up-to-date.  To reset the holidays that are displayed in your calendar, you click the Add Holidays button.  Then you select a checkbox for the holidays that you want to include, for example Singapore, and you click OK.  If you travel to other time zones on business, you can change the current time zone in your calendar to match the time zone you are in.  And you can add a second time zone to your calendar if you schedule meetings or conference calls with coworkers in other time zones.  If you change the time zone in Outlook, the times in all other Windows applications on your computer will change as well.This is because changing the time zone in Outlook is equivalent to changing the time zone in the Windows Control Panel in your computer settings.  To change the current time zone, you click the Time Zone button in the Calendar Options dialog box.  You type a description of the time zone that you want to change to in the Label text box.  And you select the time zone you want to revert to, in this case Central Time (US & Canada), in the Time zone list box.  If you want to add an additional time zone to Outlook, you select the Show an additional time zone checkbox.  And you select the time zone, in this case Singapore, from the drop-down list.  Then you type a description of the time zone in the Label text box.  You can select the Adjust for daylight saving time checkbox if the time zone you have chosen allows for it.  You can switch between a first and second time zone by clicking the Swap Time Zones button.  When you have customized the time zones, you click OK.  You click OK in the Calendar Options dialog box.  And you click OK again in the Options dialog box.  And the new calendar options are applied to your Outlook calendar.
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You can use Outlook to schedule meetings and online broadcasts on the Internet.  You can also configure Outlook to schedule meetings with people who do not use Outlook.  If you want to send meeting requests to people over the Internet or to people who do not use Outlook, you use Internet Calendaring (iCal).  To receive an iCal meeting request, the recipient also needs to be using an iCal compliant program.  To convert a meeting request to iCal format, you click File - Save As.  In the Save As dialog box you browse to the location in which you want to store the iCalendar file, in this case the Catalog meetings folder.  Then you select iCalendar Format from the Save as type drop-down list.  And you click Save.  You can now attach the iCal file to an e-mail message to schedule an appointment.  To configure a meeting request for iCal format while you are creating it, you fill in the attendees but you do not send the request.  Instead, you select Actions - Forward as iCalendar.  A new e-mail dialog box appears with the iCal attachment included and you enter a message to send with the meeting request.  You can also fill in the names of attendees at this point if they are not already included.  You click Send and the meeting request is sent as an Internet mail message.  The recipients of the iCal meeting request can choose to decline the request or to accept it and add it to their calendars.  You can use vCalendar format instead of iCalendar format to schedule appointments over the Internet.  vCalendar is an Internet standard that works in a similar way to iCalendar.  But you use it when recipients' computers do not support iCal, for example when they are using older versions of Outlook.  To save an appointment in vCalendar format, you select the File menu.  And you select Save As.  In the Save in dialog box you select browse for the location in which you want to save the file, in this case Catalog meetings.  And in the Save as type text box you select vCalendar Format.  When you have chosen a name and location for your vCalendar file, you click Save.  You can now attach the vCal file to an e-mail message to schedule an appointment.
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Suppose that you want your coworkers to be able to schedule meetings with you on the Internet.  To do this, you need to make your free/busy times available to the network so that your coworkers have access to your calendar at a central location.  To publish part of your calendar on the Internet, you select the Tools menu in the Calendar view.  And you select the Options option.  Then you click the Calendar Options button on the Preferences tabbed page to access your calendar's Free/Busy options.  In the Calendar Options dialog box you click the Free/Busy Options button.  And you select the Publish my free/busy information checkbox.  Then you type the Internet location for your calendar times in the Publish at this URL text box and you click OK.  You can use vCalendar format to publish part of your calendar instead of vfb format.The URL then reads, for example, http:\\computer102\calendar\ac.vcs.

If you want to be able to access other people's free/busy information, you type the URL for their information in the Search this URL text box.  You need to include at least one variable value in this URL, so that Outlook can vary its search depending the name of the person you're searching for.  In this case you place only the %name% variable in the URL but you can provide a %server% variable as well.  When you have completed the settings for your free/busy times, you click OK.  And you click OK again in the Calender Options dialog box.  In the Calendar view you select the Tools menu.  And you select Send/Receive - Free/Busy Information to publish your calendar times on the Internet.  When you send your free/busy information, Outlook creates the new file in the location you have specified on your web server.

4 of 11

You can use the Outlook calendar to schedule real time meetings using NetMeeting.  And you can use it to schedule times for broadcasts using NetShow.  To do this, you need to have NetMeeting and NetShow services set up on your computer.  If you want to schedule a real time meeting from your calendar using NetMeeting, you select File - New.  Then you select Meeting Request.  You type the names of the people whom you want to invite to the meeting in the To text box or you click To to select the names from a list.  In the Subject text box you type a description of the meeting, which is used as the NetMeeting conference name.  You can change the conference name only in the Subject text box.  And you enter times in the Start time and End time text boxes or you use the spin box arrows to select times for the meeting.  To ensure that you use NetMeeting to start the meeting, you select the This is an online meeting using checkbox.  And you select Microsoft NetMeeting from the drop-down list.  If you want to set a reminder for your NetMeeting conference, you select the Reminder checkbox.  And you can select the Automatically start NetMeeting with Reminder checkbox to ensure that NetMeeting is running before the meeting begins.  When you have completed all the settings for your online meeting, you click Send.  If you want to start a meeting with a single person immediately, you access the Contacts dialog box and you select Actions - Call Using NetMeeting.  Suppose that you want to schedule an online broadcast using NetShow from Outlook.  To do this, you select the File - New - Meeting Request.  Then you type the names of the recipients into the To text box and you type a description of the meeting in the Subject text box.  You can also click the To button to select the invitees from your Outlook address book.  In the New Meeting Request dialog box you select the This is an online meeting using checkbox.  And you select NetShow Services from the drop-down list.  If you want to set a reminder and you want NetShow to start running automatically, you select the Reminder checkbox and the Automatically start NetShow with Reminder checkbox.  In the Event Address text box you type the location at which the broadcast can be found.  When you have selected all the options for your meeting, you click Send to schedule the broadcast.

5 of 11 (5-6 THE OUTLOOK FAX SERVICE)

Outlook allows you to send faxes instead of e-mail messages or to fax documents from other Office applications.  And you can attach a cover page, files, and pictures to your fax.  If Outlook's e-mail service is configured for the Corporate or Workgroup option, you need to download the Microsoft At Work Fax program to send faxes.  You can do this using the Office on the Web option in the Help menu.  But if Outlook is configured to use the Internet Only option, you can use the Symantec Fax Starter Edition that is installed with the Office suite from the Office 2000 CD.  Suppose that you want to create a cover page for all your faxes and then send a fax to a coworker.  To do this, you select Tools - Options.  And you click the Template button on the Fax tabbed page.  If the Fax tabbed page is not available in the Options dialog box, you need to install the fax software from your Office 2000 CD.  In the template dialog box you select the Send Cover Page checkbox and you select the cover page - in this case Strong Standard from the Template drop-down list.  And you click OK.  You can click Apply before you click OK to apply the cover page setting without closing the dialog box.This enables you to view the preview of the cover page without applying it to the document immediately.  When you have chosen your cover page, you click OK to complete the cover page configuration.  The cover page automatically prints your name, addresses, telephone numbers, and company details from the computer's records.You can edit these details at any time.  To begin creating your fax, you select the File menu from the Outlook toolbar.  And you select New - Fax Message.  In the Subject text box you type the subject of the fax, in this case Distribution policy concerns.  Then you type the body of your fax.  Because you want to attach a Word document to your fax, you select Insert - File.  Then you select the file you want to attach, in this case Distribution policy.doc, and you select Insert as Attachment.  And the file is attached to the fax document.  If the recipient's fax number is in your Contacts folder, you can click the To button.  And you select the name from the Contacts list and click OK.  The recipient's name appears in the To text box on your fax and you click Send to send the fax.  If the recipient's name is in the Contacts folder without the fax number, you can still enter the recipient's name using the To button.  But after you click Send, Outlook prompts you to provide a fax number and you need to type it in and click Send again.  If you want to send a fax to someone who is not in your Contacts folder, you may type a fax number instead of entering the recipient's name using the format fax@number.  If you do this, you may need to enter an outside line number plus a w, in this case 9w, and Outlook prompts you to confirm the fax number before you send the fax.
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Suppose that you want to customize a fax that you are sending to a colleague.  To do this, you select Tools - Options.  On the Fax tabbed page of the Options dialog box, you click the Edit button to change the information on your cover page.  And you can change the information in any of the text boxes in the Cover Page Properties dialog box to adjust the information on your fax.  You can customize your fax further using the Template button to change the appearance of the cover page.  And you can use the Modem button if you want to change the modem that you use to send faxes or you want to add another modem line for faxing.  When you have customized your fax, you click Apply to save the new settings.  And you click Close to return to the current Outlook view.  Suppose that you want to set Outlook so that you can receive faxes from coworkers.  To do this, you select Tools - Options.  On the Fax tabbed page of the Options dialog box, you select the Automatic receive fax checkbox.  You can also adjust the settings in the Answer after … ring(s) spin box to specify how long Outlook has to wait before it answers a fax call.  When you have completed all the settings to receive a fax, you click OK to apply the new settings.  You can click Apply before you click OK if you want to apply the settings but you do not want to close the Options dialog box yet.

7 of 11 (7-8 NEWSREADER)

Microsoft Outlook Newsreader allows you to gain access to Internet newsgroups and view the messages in them.  You can also post your own messages to newsgroups or reply to messages you have read.  Let's say that you want to access and make use of Newsreader.  To do this, you select the Go To option from the View menu.  Then you select the News option.  To read and post messages in any of the newsgroups on a server, you need to set up an account on that server.  To do this, you select the Tools menu.   Next you select the Accounts option.  The Internet Accounts dialog box opens displaying the registered accounts and information about their type and connection.  To create a Newsreader account, you click the Add button in the Internet Accounts dialog box.  And then you select News.  The Internet Connection Wizard is invoked and you type the username you want to appear on e-mail messages you post to newsgroups and click Next.  People can respond to your e-mail messages by posting another e-mail message or by sending an e-mail message directly to you so you provide your e-mail address and click Next.  You need to enter the name of your Internet news server - this name is usually supplied by your Internet service provider (ISP) or by your IT administrator.  Then you click Next.  And you click Finish.  The new newsreader account is now displayed in the Internet Accounts dialog box and you click Close to return to Newsreader.  Once you've added an account, you can download newsgroups by clicking the Yes button.  All of the available newsgroups on your news server are downloaded.  And these are now listed alphabetically in the Newsgroup Subscriptions dialog box.
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Let's say that you want to subscribe to a sport newsgroup about bungee jumping and that you want to post a message to it.  To do this, you select the Subscribe to Newsgroups option.  To subscribe to a newsgroup on a particular subject - in this case sport - you type a keyword in the Display newsgroups which contain text box, select the newsgroup from the list, and click Subscribe.  By subscribing to a newsgroup, you'll receive notification of its latest updates and information.  Then you click the OK button.  Newsreader allows you to view all the subject headers in a newsgroup.  Suppose that you want to post a message to alt.sport.bungee.  You select alt.sport.bungee and you click the New Post button on the toolbar.  You type the subject of your message in the Subject text box and you complete the message.  Then you click the Send button.

9 of 11 (9-11 ABOUT SHARING FOLDERS)

Outlook, used in conjunction with Microsoft Exchange Server, allows you to share your private folders.  For example, your manager may want to see your schedule or a colleague may need to access your Contacts folder.  Outlook makes it easy to grant your coworkers permission to access your private folders without compromising your security.  You can set particular roles, such as author, nonediting author, contributor, and reviewer, for each coworker.  These roles will enable them to make the changes you want them to make but not to access and modify sensitive information.  Suppose that Joe Mendez wants to allow Helen Campbell access to his Contacts folder.  To do this, you right-click the Contacts option in the Outlook Shortcuts folder.  Next you select Properties from the Shortcut menu.  You click the Permissions tab to set the sharing permissions for the Contacts folder.  You click the Add button.  You scroll down, select the name from the list, and click Add.  You then click OK.  Suppose that you want to give Helen Campbell the author role for your Contacts folder so you select her from the list.  Next you click the Roles down-pointing arrow.  You select the role of Author.  You can see that the role of Author allows her to create and read items as well as edit or delete her own entries.  However, she is not allowed to create subfolders.  You click the Apply button.  And to continue, you click OK.  Let's look at how you open another person's folder to which you have been granted access - in this case you are Helen Campbell.  You select File - Open - Other User's Folder.  You type the name of the person who granted you sharing permission in the Name text box.  To specify the folder to which you've been given sharing permission, you click the Folder down-pointing arrow.  Next you click the folder you want to open - in this case, Contacts.  You click the OK button.  Since you've been granted access to Joe Mendez's Contacts folder, this folder opens.
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Outlook 2000, used in conjunction with Microsoft Exchange Server, allows you to use public folders.  Public folders make it easy to collect, organize, and share information with coworkers.  You can use public folders to store and share any type of file as well as Outlook items.  For example, you might use a company journal folder to note important events or activities.  Or you may use a departmental task folder to keep everybody up to date with the progress of a special project.  Public folders have to be created and designed by users with the appropriate permission.  By default, all users can view the contents of public folders.  Permission levels control users' access rights to public folders.  Public folder permission levels are assigned in the same way as those for private folders.  The permission level - or role - granted to you determines both the nature and the scope of your permitted activity within a folder.  For example, if you are assigned the role of Editor, you are allowed to read, create, edit, and delete a folder.  However, you are not allowed to create subfolders.  Permission to access and modify public folders is granted on a folder-by-folder basis.  This means that having access to a particular folder does not necessarily mean that you can access any other folders or even subfolders of the folder you have access to.  Owner permission allows you to

• create and modify the contents of folders

• read items

• delete any items

• create subfolders

• change the permission levels for other users

You must have Owner permission for a public folder to limit access to the folder.  Suppose that you want to access and modify the public folder, called Policy, which contains the proposals for a new employment policy.  To check your permission level for the Policy folder, you right-click Policy and select Properties from the pop-up menu.  In the Policy property sheet, you click the Permissions tab.  If the Permissions tab is not present, you do not have Owner permission.  As you can see you have been assigned the Owner role.  This means that you can manipulate the folder in any way you like by creating new items or editing and deleting existing items.  You click OK to close the property sheet.
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Suppose that you want to create a subfolder for the Policy folder that allows other users to contribute ideas on a proposed policy.  To create this folder, you right-click the Policy folder and select New Folder.  Alternatively, you select File - Folder - New Folder.  In the Create New Folder dialog box, you type the name of the new folder, Policy Forum, in the Name text box.  From the Folder contains drop-down menu, you select the type of folder you want to create - in this case, you select Mail Items.  The type of item selected determines the items the folder can contain.  You click OK to close the Create New Folder dialog box.  Now that you have created the folder, you can assign permissions to it.  To assign permissions, you right-click the new Policy Forum folder.  To assign permissions to the folder, you select Properties from the Shortcut menu.  Then you click the Permissions tab.  You have the option of assigning the same role to everyone or creating a customized role for particular individuals.  A Publishing Editor has permission to create, modify, or delete the contents of a folder, and create subfolders.  To assign a colleague the role of Publishing Editor to access the Policy Forum folder, you click Add.  Then you select the person's name, in this case, Helen Campbell and you click Add.  Then you click OK to close the dialog box.  You select the Publishing Editor role for Helen Campbell from the Roles drop-down list.  Then you click OK.  Helen Campbell has now been given permission to create, modify, or delete the contents of the Policy Forum folder, and to create subfolders.

END OF COLLABORATION

SUMMARY: You have seen how to use Outlook for network collaboration.  You can configure your Outlook calendar to make communication with coworkers in other countries or time zones easier. For example, you can configure your calendar to reflect holidays in other countries or to reflect a time zone other than the one you are in.  Outlook allows you to use the iCalendar and vCalendar applications to configure your calendar so that you can make appointments with coworkers over the Internet and you can make your calendar available to others on the Internet. The iCalendar facility also allows you to make appointments with people on your network or on the Internet when they do not use Outlook.  Outlook allows you to send faxes as well as e-mail messages. You can customize your fax cover pages. You can also determine the priority and sensitivity of your faxes and you can encode them or attach a digital signature if you need to. You can set delivery and expiry dates and request automatic confirmation when your message has been read.  You need to set your computer to receive fax messages automatically.  Newsreader allows you to gain access to Internet newsgroups and view the messages in them. You can also post your own messages to newsgroups or reply to messages you have read.  Outlook used in conjunction with Microsoft Exchange Server allows you to share your private folders. Outlook makes it easy to grant your coworkers permission to access your private folders without compromising your security.

UNIT TEST:

1. Which of the following are options that you can configure for your Outlook calendar?

a. The time zones displayed in the calendar

b. The holidays displayed in the calendar

c. The first day of the work week

d. The working hours during the week

e. The colors used to designate meetings

2. Is the following statements true or false?  When you configure your calendar with two time zones, you can move the settings in your calendar between the time zones.

a. True

b. False

3. You use the _____ file format to send meeting requests over the Internet from within Outlook and you use the _____ file format to make your own calendar available for meetings to be scheduled over the Internet.

a. vCalendar

b. iCalendar

4. If you want to schedule an online meeting using an Outlook e-mail message, you need to access NetMeeting and schedule the meeting from there.

a. True

b. False

5. Which of the following are true of using Outlook to schedule online meetings or online broadcasts?

a. You need to construct a meeting request before you designate it as a NetMeeting or a NetShow

b. You need to provide a location for a NetShow

c. Outlook starts NetMeeting or NetShow by default when you receive a meeting reminder

d. You need to provide a description of the meeting

6. Which of the following statements are true of sending faxes from Outlook?

a. You can configure a cover page for your fax

b. You can fax an existing Office document

c. You can send faxes using recipients’ e-mail addresses

d. You need to set your computer to receive faxes

7. If you have configured Outlook for Corporate or Workgroup use, you need to use the _____ program to send faxes and if you have configured your computer for Internet Only use, you need to use the _____ program.

a. Symantec Fax

b. At Work Fax

8. In which of the following ways can you customize a fax message?

a. You can determine its importance

b. You can send it as an mail attachment

c. You can encode it

d. You can determine when it is delivered

e. You can set it to expire after a certain date

9. Which of the following statements about Newsreader are true?

a. It allows you access to Internet newsgroups

b. It allows you to view the messages in Internet newsgroups

c. It does not allow you to view the messages in Internet newsgroups

d. You can also post your own messages to newsgroups

e. You can reply to newsgroup messages

f. You can post your own messages to newsgroups but you cannot reply to newsgroup messages

10. If users are given a Shortcut to a private Outlook folder, they must use Outlook to access the private folder.

a. True

b. False

11. Which of the following statements about private folders are true?

a. Sharing private folders must be applied to all users and cannot be restricted to selected users

b. You can grant the individual permissions without having to assign a role

c. Sharing permission for a private folder does not have to be set if a user has a shortcut to the folder

d. A shortcut to a folder does not mean a user has sharing permission for a private folder

12. What determines whether users are able to view the contents of a public folder?

a. The sensitivity level of the folder

b. The AutoArchive date

c. Permissions

13. Identify the actions that users can perform if they have Owner permission for a folder.

a. Create folders

b. Read files and folders

c. Modify the contents of folders

d. Delete any items

e. Create subfolders

f. Change other users’ permission levels

ANSWERS:

1. a, b, c & d

2. True

3. 1st blank: iCalendar, 2nd blank: vCalendar***

4. False***

5. a, b & d***(a)

6. a, b & d

7. 1st blank: At Work Fax, 2nd blank: Symantec Fax

8. a, c, d & e***(c)

9. a, b, d & e

10. True***

11. b & d***(cd)

12. c

13. a, b, c, d, e & f

ADVANCED OUTLOOK

OPTIMIZATION 
1 OF 9 (1-4 CUSTOMIZING OUTLOOK)

Outlook's improved viewing options include Outlook Today and the preview pane.  These options are designed to increase usability and to further integrate the management of e-mail, calendar, and task information.  The Outlook Today view displays an overview of your calendar, tasks, and e-mail messages in a web page format.  It is customizable and can be displayed as the default view on opening Outlook.  Each subsection and item displayed in the Outlook Today page is hyperlinked to its relevant feature.  For example, to view a calendar event, you click a calendar reminder.  And you are then able to read the details of the appointment.  By default, the preview pane in the Outlook Inbox allows you to view the first few lines of your e-mail messages.  You can adjust the viewer's splitter bar or you can scroll down in the preview pane to view as much of the selected message as you want.  So you have the option of viewing the contents of a message without having to open a separate window.  The preview pane provides support for HTML, graphics, hyperlinks, attachments, and encrypted mail.  This allows you to work with all the contents of a message without opening it.

2 OF 9

Let's say that you want to set Outlook Today as your default view and you want six days of your calendar to be viewable in your Outlook Today view.  You also want to change the style of your view.  So you click the Customize Outlook Today button.  To make Outlook Today your default view in Outlook, you select the When starting ... Outlook Today checkbox.  Then to change the number of days viewable in your calendar, you select 6 from the Calendar drop-down list.  And you scroll down and select a style - in this case Summer - from the Styles drop-down list.  To save your changes and return to the Outlook Today view, you click the Save Changes button.  And the changes are applied to the Outlook Today view.
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You can customize your Outlook menus and toolbars.  For example, you can add and remove buttons and menus on toolbars, create your own custom toolbars, hide or display toolbars, or move toolbars.   Suppose that you want to display the Advanced toolbar but you don't want the Rules Wizard button on the toolbar.  To display the toolbar, you right-click any toolbar.  You then choose Advanced from the list or you can select Customize to use the Customize dialog box.  The Customize dialog box opens on the Commands tabbed page.  And you click the Toolbars tab.  Then you select the Advanced checkbox and click Close.  To remove the Rules Wizard button from the toolbar, you click the More Buttons down-pointing arrow.  Then you click the Add or Remove Buttons button and you select the button that you want to remove.  The button is then removed from the toolbar.  Let's say that you want to add a button to a custom toolbar that will activate a command, such as the Search the Web command.  To do this, you select the Tools menu.  And you select the Customize option.  Alternatively you right-click the toolbar and select Customize.  In the Customize dialog box you click the Commands tab.   Next you select the appropriate category for the command you want the button to perform.  Then you select the command or macro you want from the Commands list and drag it to the toolbar.   The button is now added to the Advanced toolbar.  And you click Close to return to Outlook Today.  Outlook allows you to add a built-in menu to a toolbar.  For example, suppose you want the Favorites menu to be displayed next to the Search the Web button on the Advanced toolbar.  To do this, you select Customize from the Tools menu.  Alternatively you right-click the toolbar and select Customize.  On the Commands tabbed page of the Customize dialog box you select Menu Bar from the Categories list.  You select Favorites and drag it next to the Search the Web button.  The Favorites menu now forms part of the Advanced toolbar and you click Close to return to Outlook Today.
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In addition to being able to customize your toolbars, Outlook allows you to customize your views and the Outlook bar.  You can customize the current view or create your own view.  And you can add folders to the Outlook bar.  Let's say that you want to create a custom view for your Outlook Inbox window.  First you select Current View from the View menu.  Then you select the Define Views option.  To create a custom view, you click the New button.  Next you type a name for your view in the Name of new view text box and you choose the view type you prefer from the Type of view list.  Then you choose on which folders this view should be used and to whom it should be visible - in this case you select the This folder, visible only to me radio button and you click OK.  You are asked to specify the view settings for your new view and - in this case - you click the Sort button.  Next you select an option from the Sort items by drop-down list - in this case you choose the Sensitivity option.  Then you click OK.  When you have finished setting options, you click OK.  And to use the view immediately, you click Apply View.   The Icon view type is now displayed and the messages are sorted according to sensitivity.  The icon used on the mail titled ‘brand' indicates that the mail has already been opened.  To create a shortcut on the Outlook bar for a folder, you right-click the bar.  And you select the Outlook Bar Shortcut option.  You select the folder that you want to add to the Outlook bar - in this case Anita Cook's mailbox - from the Folder name drop-down list.  Then you click OK.  Anita Cook's mailbox now appears as a shortcut on the Outlook bar.

5 OF 9 (5-9 FORMS)

Outlook comes with a variety of features designed to make it easy for you to record, organize, and access information.  One very useful feature is the Outlook Forms Designer, which enables you to design electronic forms.  Forms are used to collect and distribute information.  Most types of request or reporting process in your organization can be automated and streamlined with electronic forms.  Using the Outlook Forms Designer, you can create different types of form without having any programming experience.  An Outlook form is made up of the following components:

• one or two form windows

• the window fields

The form window is the basic canvas for designing a form, providing the container for the fields you add to it.  A one-window form uses a single window for reading and composing information.  A two-window form has separate compose and read pages.  The window fields are the components of the form window and are the basic units you use to design forms.  Forms are stored in form libraries.  In Outlook there are three libraries:

• Personal Forms Library

• Standard Forms Library

• Organizational Forms Library

Personal forms are stored in your mailbox and are accessible only to you.  A meeting request form is an example of such a form.  Standard forms stored in a private folder are accessible to you alone, while standard forms stored in a public folder are accessible to everyone with access rights to that folder.  A customer profile form is an example of such a form.  Organization forms are accessible to everybody and are stored on the server.  A vacation request form is a typical organization form.
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To create a form, you select Tools - Forms - Choose Form.  The Choose Form dialog box displays and you can choose a folder in which to locate a form from the Look In drop-down list - in this case you select Standard Templates.  You accept the default template and click Open.  The default form is used when the form required is not listed in the New Form list.  The standard template is displayed.  To design the form, you choose Tools - Forms - Design This Form.  This puts you in Design mode and the Field Chooser dialog box is shown.  The Field Chooser dialog box displays a list of predefined fields that you can use in your form.  It also allows you to define and save your own frequently used fields.  You can close the Field Chooser dialog box to get a better view of the layout of the form.  The tabbed pages enable you to view and change different sets of options.  You click the Control Toolbox button to add control fields to your form.  And the Toolbox is displayed.
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Let's say that you want to create a new form on the P.2 tabbed page by using the Toolbox options.  The Label button allows you to label a section of your form or to display a text or number pattern.  Using the TextBox button, you can add a text box to your form so users can enter required information.  The ComboBox button allows you to create drop-down list boxes.  And the ListBox button lets you create standard list boxes.  You can select options from list boxes but, unlike combo boxes, you can't type a new value.  You use the CheckBox button to provide checkable options in your forms.  And you can use the OptionButton button to provide choices or options.  But you can choose only one option from a set of options grouped together.  The Toggle Button is used to show whether an item is selected or to select one or more of a group of items.  For example, you can create an order form with a list of available items with a toggle button preceding each item.  You can use the Frame button to create a container field that groups other kinds of fields in it.  For instance, you can create a frame and then place one or more checkboxes in it.  You can then give each checkbox a label.  You can use a frame to define boundaries of groups of option buttons - for instance, if you want users to select one of a group of options, you group them in the same frame.  Users can't select multiple option buttons in the same frame field.  But you can create frames within frames if you want to offer several separate groups of options.  Option button fields can contain other fields but always use a frame field as their container.  A CommandButton button starts, ends, or interrupts an action or a series of actions.  For example, you can have a command button labeled "Exit" that closes a form when clicked by a user.  A TabStrip is a control that contains a selection of one or more tabs - each tab of a TabStrip is a separate object that users can select.  For example, you can have a form with a weekly schedule for a group of individuals in a department.  Each individual has a separate tabbed page, accessed by clicking the relevant tab on the TabStrip.  A MultiPage control is a control that contains a collection of pages.  It is useful for handling large amounts of information as it allows you to group information about different topics on separate pages.  For example, you can use a MultiPage control for displaying information related to employment applications - personal details can be listed on one page, educational achievements on another, and previous experience on another.  A ScrollBar is a standalone control that you can place on a form, but it is usually used to set the value of another control.  To use the ScrollBar to set or read the value of another control - for example a TextBox - you need to write Visual Basic programming code.  A SpinButton is used to display incrementing or decrementing numbers - for example the value of other controls on a form.  And the Image control allows you to display a picture on a form.
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Suppose that you want to create a form on the second tabbed page - P2 - that standardizes the way travel expenses are submitted to the Accounts Department.  You want to add various controls to the form that allows users to enter information.  Let's say that you want to insert a label in your form, so you click the Label button on the Toolbox.  You place the cross hair at the point where you want to position the label and then drag it across the frame.  When you release your mouse button, a label called "Label1" is in place.  To change the properties of the label, you right-click the label and choose Properties from the shortcut menu.  Alternatively, you can select the Properties option from the Form menu.  The Properties dialog box then opens.  To define the type of input that users can insert in this field and the format the field will accept, you click the New button on the Value tabbed page.  The New Field dialog box appears and you type the form name in the Name text box and verify that the Type and Format fields display the type and format that you want.  You can specify a different kind of input for a field by selecting options from the Type and Format drop-down lists.  When you have finished setting the type and format of input this field will accept, you click OK.  To change the name and caption of this field, you return to the Display tabbed page, type titles in the Name text box and Caption text box - in this case both are labeled Destination - and click the Apply button.  The caption on the label changes and you click OK to close the Properties dialog box.  Suppose that you want to insert a text box beside the Destination label so that users of the form can enter their destination.  To do this, you click the TextBox button on the Toolbox.  You place the cross hair at the point where you want to position the text box, drag your mouse, and then release it to create the text box.  You can change the size of the text box by dragging one of the eight positioning handles that appear around it.  Suppose that you want to ask users if they will require accommodation so you create an Accommodation label.  And as the answer to this question will be either yes or no, you want to create a field that allows them to specify one or the other.  You click the OptionButton button on the Toolbox to insert an OptionButton control in your form.  Then you right-click the OptionButton field and choose Edit from the shortcut menu.  A small frame appears in the OptionButton field and you type Yes.  You place another option button beneath the "Yes" button.  And you give this one a "No" caption.  You have now completed the Travel Expenses form by standardizing the way travel expenses are submitted to the Accounts Department.
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Let's say that you want to set general properties, such as specifying the form category and naming a contact, for the Travel Expenses form.  To do this, you click the Properties tab.  You fill in the Form Category field and enter your name in the Contact field.  If the form needs to be modified at a later stage, it can be given a different version number to avoid confusion.  If you want to prevent other people altering this form without consulting you first, you select the Protect form design checkbox.  The Password dialog box displays and you type a password in the Password and Confirm text boxes and click OK.  Once you've returned to the Message tabbed page you can save the standardized form.  To do this, you select Save As from the File menu.  You select the folder you want to save your form in, type a name for the file, and click the Save button.  Outlook automatically gives your form a file extension of .oft.  When users access this form, they receive the standard mail template.  And they receive the P.2 tabbed page that you created.

END OF OPTIMIZATION

SUMMARY: You have seen how to optimize Outlook.  Outlook 2000 offers the Outlook Today view. This window provides a summary of your calendar, tasks, and e-mail messages in a single screen. The Outlook Today view can be made the default view in Outlook and can be customized.  The Inbox in Outlook's preview pane allows you to view messages and their attachments without having to open a separate window. This feature can also help you to prioritize reading your mail as it shows the first few lines of any selected mail.  Forms can help to streamline and standardize any type of request or reporting process. The Outlook Forms Designer is a nonprogramming design tool that you can use to design forms.

UNIT TEST:

1. Which of the following are summarized in the Outlook Today view?

a. Contacts

b. Tasks

c. Calendar

d. Messages

e. Journal

2. Which of the following are true of Outlook Today?

a. It contains hyperlinks to each feature summarized in this view

b. It is a management application for the features that it summarizes

c. You are able to view tasks and the times and dates of calendar appointments in this view

d. You can customize what is shown in this view

3. To add control fields to a form, you use the _____.

a. Field Chooser

b. Control Toolbox

c. Control HotSpots

4. Which control do you use to create a container field in which you can group other kinds of fields?

a. MultiPage

b. Frame

c. ComboBox

d. ListBox

5. The _____ control is used to provide multiple options on the same frame and the _____ control lets you create a standard list box.

a. ListBox

b. CheckBox

6. Is it possible to change the format of a field once you’ve created it?

a. Yes

b. No

ANSWERS:

1. b, c & d

2. a, c & d

3. b

4. b

5. 1st blank: CheckBox, 2nd blank: ListBox

6. Yes

ADVANCED OUTLOOK

INTEGRATION

1 OF 7 (1-2 INTEGRATING DATA)

Outlook 2000 is designed to integrate with the other Microsoft Office 2000 applications.  For example, you can create an Excel document in Outlook and send it as an e-mail message if you have the Excel application installed on your computer.  You can also create a document in an application, for example Word, and then send it directly as an e-mail message to a recipient from that application.  Creating an Office document in Outlook or sending it directly by e-mail from any Office application ensures that the document is not sent as an attachment.  The document is sent in HTML format and can be modified directly by the recipient.  To create an Excel document - for example - in Outlook, you select File - New - Office Document.  You select the icon for a file type - in this case the Excel icon - and you click OK.  A message box displays giving you the option of sending the document via e-mail or posting it to the current folder - you select Send the document to someone and you click OK.  Alternatively you can use the Send document to someone button on the tool bar or you can choose to send the document as an attachment or fax it to a recipient.  You enter the e-mail address and click the Document tab to begin creating the document.  Once you have created the document, you click the Send button.  Let's say that you want to send a Word document directly to a mail recipient from Word.  To do this, you select File - Send To - Mail Recipient.  You then include the recipient's details and click the Send a Copy button.

2 OF 7

You can import and export data between Outlook and other Office applications.  You can also import data from other e-mail applications, such as Microsoft Mail or Eudora Pr, to Outlook but you cannot export data from these applications.  The method you use to import or export data depends on the format of the files that are being transferred.  Let's say that you want to import a Personal Address Book (pab) into your Contacts folder.  And suppose that you want to export your Journal to a personal folder file in order to archive it.  To import a pab to Outlook, you select File - Import and Export.  You select the Import from another program or file option and click Next.  You select Personal Address Book from the Select file type to import from text box.  And you click Next.  A pab is automatically selected in the File to import text box.  You can type the filename and location of a different pab or browse to a different pab if you don't want to import the automatically selected pab.  In this case you want to import this pab, so you click Next.  You can import your pab to a destination other than the Contacts folder by clicking the Change Destination button and specifying a new destination.  Or you can map custom fields by clicking the Map Custom Fields button.  But in this case you click Finish.  To export a file from Outlook to a personal folder, you select File - Import and Export.  Then you select the Export to a file option and you click Next.  The standard file format for Outlook is a .pst file so in this case you are exporting from a .pst file to another .pst file.  You select the file type that you want to create - in this case the Personal Folder File (.pst) option.  If you want to export a file for use in Word or PowerPoint, you select the Comma Separated Values file type or the Tab Separated Values file type.  And you click Next.  You select Journal as the folder that you want to export and you click Next.  You can then specify a filename and location for the created file or accept the default.  And you click Finish.  In the Create Microsoft Personal Folders dialog box you specify a name, encryption setting, and password for your Personal folder.  And you click OK to export your Journal folder.  You can choose to export an Outlook folder to an existing folder.  When you follow this option, you can choose whether to overwrite the duplicates in the folder or to create a copy for duplicates of the files.  You can also choose not to export duplicate files.

3 OF 7 (3-4 ADVANCED CONTACTS)

Contacts are integrated with all other Outlook components.  For example, you can create an e-mail message, Journal entry, or task relating to the selected contact in the Contacts folder.  Contacts are integrated with Office components other than Outlook.  You can create a letter in Word to a selected contact or directly call a contact using the Actions menu.  You can access many of the integration options of the Contacts folder by right-clicking the contact that you want the action to relate to.  You can link items or files to a contact.  This links the file or the item to the Activities tabbed page of the contact and you can choose to view a range of different types of link.  And you can directly access a linked contact from the item that it is linked to by double-clicking the contact's name in the Contacts text box.  Let's say that you want to create a new task related to a contact, Aung Sun Dun.  To do this, you select Actions - New Task for Contact.  This opens a new task that you can fill in.  You can create a new contact from any Outlook item by dragging it to the Contacts button on the Outlook Bar.  For example, you can create a new contact from an e-mail message in your Inbox.  The contact opens with the e-mail message details included and you can then enter the rest of the contact's information.  You can place a flag on a contact to remind you that you need to follow up something relating to that contact.  You can place a flag on a contact to remind you to 

• follow up the contact

• call the contact

• arrange a meeting with   the contact

• send an e-mail message to   the contact

• send a letter to the contact

To place a flag on a contact, you select the contact and click the Flag for Follow up button.  And you can select an action associated with the flag from the Flag to drop-down list.  You can set a due date by which you have to perform the task specified in a flag.  You can mark the flag as completed when you have performed the flagged task.  And you can clear the flag when you have finished the follow up by clicking the Clear Flag button.  You can integrate contacts with other Outlook components by linking them.  For example, you can link a particular contact to a Journal entry in your Outlook folder.  You can use contacts from any other Office application by selecting File - Send To - Mail Recipient option in any Office application - in this case Access.
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Suppose you want to create a contact from a new e-mail message.  You then want to flag the contact for a call.  You want to link the contact to a recurring meeting on your calendar.  Then you want to send an Excel worksheet to the contact.  You drag the e-mail message to the Contacts button on the Outlook Bar and drop it there.  You click the Flag for follow up button.  You select Call from the Flag to drop-down list.  You select 21 from the Due by drop-down calendar.  You click OK.  You select Actions - Link - Items.  You select Journal and click OK.   The Mail Merge feature in Office 2000 allows you to create form letters, envelopes, mailing labels, or catalogs without having to manually enter the data for each item.  Once you have created a generic document with Mail Merge, you can then print, send e-mail messages, or store the personalized documents generated from the generic document.  In order to create a Mail Merge document, you require a data source for the document - this source can be an Address Book or a filtered view of contacts in Outlook.  Let's say that you want to create a form letter thanking staff from various branches for their contributions to the distribution catalog.  And you want to send the letter to all the contacts open in the customized view of your Contacts folder.  You can activate the Mail Merge Helper from the Contacts view by selecting Tools - Mail Merge.  Mail Merge is performed in the Word application and accessing the Mail Merge Helper launches the Word application.  In the Mail Merge Contacts dialog box you select a Contacts option - in this case the All contacts in current view radio button.  You then select the fields that you want to merge.  You can choose to merge the fields in an existing document or you can choose to create a new document - in this case you choose a document that you have already created.  You select Form Letters as your document type from the Document type drop-down list.  You select where you want the merged records sent from the Merge to drop-down list - in this case E-mail.  This displays the Message subject line text box where you can type a subject and you click OK.  Word displays the form letter and you can activate the Mail Merge Helper by clicking the Mail Merge Helper button if you need to check any details.  For more information on Word's capabilities with Mail Merge see the CBT Systems course Microsoft Office 2000: Advanced Word.  Or you can merge the documents immediately by clicking the Merge button.  You can check that the e-mail messages have been sent in your Sent Items folder.  And you can view the sent items individually.

5 OF 7 (5-7 ADVANCED TASKS)

You may want to set a recurring task to remind you of an annual or a daily task.  The Task Recurrence dialog box enables you to set the frequency at which you want the task to recur.  To repeat the task at regular intervals, you select any of the options on the right side of the Recurrence pattern group box.  To repeat the task based on the date it is marked complete, you select Regenerate new task and then type a time interval in the text box.  Let's say that you are Aung Sun Dun and you want to set a new recurring task.  You want to set this task to remind you to phone Anita Cook in the Los Angeles office every day during the following week to brief her on the Singapore sales.  To do this, you click the New button.  You type a description for the task in the Subject text box.  Next you select the Recurrence button.  To set the task to run every day, you click the Daily button.  And to specify that this task should take place on weekdays only, you select the Every weekday radio button.  To set the range of days when the tasks should recur, you click the Start down-pointing arrow.  Next you select 14 from the calendar.   To specify that the recurring task should cease at the end of the week, you select the End by radio button.  Next you click the End by down-pointing arrow.  Then you select 18 from the calendar.  Once you've set the recurring task, you click the OK button.  The task displays and gives you some information about the due date of the task and the number of times it will recur.  When you're satisfied with your selection, you click the Save and Close button.
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Let's say that your company's telephone bills have to be paid before or on the fourth of each month.  To remind you of this, you have set a recurring task, named "pay telephone bills" to appear on the fourth of each month.   Since you've failed to pay the bills on time the previous month, you want to change the settings of the recurring task for the next month.  In this case you want to change the settings so that once the task has completed, a new one is regenerated a week later to remind you to confirm payment.  To update a recurring task, you open the task, which you want to change to a recurring task, by double-clicking it in the task list.   Only the owner of a task can change the task into a recurring task.  In this case you open the "pay telephone bills" task.  Next you click the Recurrence button.  The Task Recurrence dialog box contains the existing setting of the particular task.  When you select the Regenerate new task radio button, the End by radio button becomes inactive since each task is followed by the regenerated task.  You specify that you want a new task to be regenerated two weeks after each task has taken place and you click OK.  Details of the task settings, including the regenerated task, are now displayed.  Then you click the Save and Close button.  Once you have saved the task, you are returned to the Tasks list.
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You use the Journal to automatically keep track of all task requests and responses exchanged between you and your colleagues.  To do this, you select the Tools menu.  Then you select the Options menu option.  You customize your e-mail, calendar, tasks, contact, and notes options on the Preferences tabbed page of the Options dialog box.  To change the Journal settings, you click the Journal Options button.  The Journal Options dialog box enables you to specify what should or should not be recorded automatically.  For example, you may want to set Task response and Task request items to be recorded automatically and you may want to include a person - in this case Anita Cook - for whom you want to track these items.  Then you click OK.  Once you have set to record Task requests and Task responses for a contact in the Journal, and once you have assigned a task to that contact, Outlook creates a Journal entry for the assigned task.  Suppose that you want to assign a new Task to Anita Cook reminding her to phone the telephone company.  To do this, you select New-Task.  To assign Anita Cook a new task, you click the Assign Task button.  You include the necessary information, such as the task subject, and click the Send button.  An assigned task is reflected in the Journal.  To open it, you right click the Task Request option and select Open from the shortcut menu.  This opens the task request you've set and specifies Anita Cook as the contact.

END OF INTEGRATION

SUMMARY: You have seen how to integrate Outlook 2000 components.  Microsoft Outlook 2000 is designed to integrate with all other Office 2000 components. You can send e-mail directly from any application. This allows you to send Office documents as HTML e-mail messages rather than attachments. You can also create a variety of Office documents from Outlook. These documents can either be posted to shared folders or be sent directly as e-mail messages to recipients.  Data from a variety of e-mail applications can be imported into Outlook. You can also import Personal Address Book files to your Contacts folder in Outlook. Data from a variety of file types can be imported to or be exported from Outlook with the help of the Import or Export Wizards.  Using Contacts, you can create a range of other Outlook items such as a new message, note, or appointment. You can place a flag on contacts to remind you that you must follow up a particular task. You can link Outlook items or files on your computer to a particular contact.  Although Outlook cannot merge documents using the Mail Merge feature, this feature can be accessed in Outlook through the Contacts folder. This allows you to use selected contacts as your data source in a merge.  You set recurring tasks to remind you of tasks you should perform at particular intervals. To set a recurring meeting on the first of each month, for example, you set a recurring task with monthly intervals. This will remind you to attend these meetings. You can set up the Journal to record data, such as e-mail messages, notes, and phone calls automatically.

UNIT TEST:

1. Which of the following are true of Outlook’s integration with the other Office components?

a. You can send any Office document directly by e-mail from the application in which it is created

b. You can save any Office document directly into the Outlook Journal

c. You can create an Excel workbook in Outlook

d. If you send a Word document directly by e-mail from Word, the document is sent as an attachment

2. An Excel worksheet sent directly from Excel by e-mail is sent in HTML format.

a. True

b. False

3. Which of the following are true of the import capabilities of Outlook?

a. You can import Microsoft Mail files to Outlook

b. You cannot import a Personal Address Book file to Outlook

c. You can import data to Outlook from certain e-mail applications not created by Microsoft

d. You can import data to Outlook from other Office applications

4. Which of the following are true of Outlook’s export capabilities?

a. You can export Microsoft Mail files from Outlook

b. You can export a Personal Address Book file from Outlook

c. You can export data from Outlook personal folders

d. You can export data from Outlook to other Office applications

5. Which of the following can be created from a contact?

a. A new e-mail message

b. A worksheet

c. An appointment

d. A Journal entry

6. Which of the following reminders can a flag be used for?

a. To follow up a contact

b. To call a contact

c. To arrange a meeting with a contact

d. To make a lunch date

7. Which of the following statements about existing tasks and recurring tasks are true?

a. The author of a task can change a task into a recurring task

b. The editor of a task can change a task into a recurring task

c. The creator of a task can change a task into a recurring task

d. The owner of a task can change a task into a recurring task

ANSWERS

1. a & c

2. True

3. a, c & d

4. a, c & d

5. a, c & d

6. a, b & c

7. c & d***(a)

END OF ADVANCED OUTLOOK

